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English

Welcome!
Thank you for purchasing the Solmetric SunEye™, the 
revolutionary new tool for solar access and shade analysis.  We 
are confident you will find it easy to use and the right tool for the 
job.

Please verify that you have received all of the following items:

SunEye••

Padded carrying case••

CD-ROM••

ActiveSync/USB cable••

Wall charger with adapter••

Shoulder strap••

Stylus••

Quick Start Guide••

The User’s Guide is in electronic form only and is accessible 
from the CD-ROM or via the help menu in the Desktop 
Companion Software.
 
Thank you again, and be sure to visit our web site at:
www.solmetric.com for software updates and new products.

Solmetric Engineers and Staff

All Solmetric packaging and paperwork are made from recycled or reused materials.
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The Solmetric SunEyeTM

1 Compass 6 Touchscreen and LCD

2 Protective Cover 7 Five-way navigation button

3 Power on/off  button 8 Device/USB and charger port

4 Fish-eye lens and digital camera 9 Soft reset pin-hole

5 Bubble level 10 Tripod Mount

11 Shoulder Strap attachments
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English

1  Install the Solmetric SunEye 
Desktop Companion Software from 
CD-ROM
Insert the CD-ROM that came with the Solmetric SunEye into the CD  •
drive on your Windows Vista, Windows XP, or Windows 2000 desktop 
computer.

If the welcome screen does not automatically open, click  • Start then My 
Computer and double-click on the CD drive or directly run setup.exe 
from the CDROM.  Follow the instructions.  If not already installed, it 
will automatically install Microsoft ActiveSync (for Windows XP and 
Windows 2000) or Window Mobile Device Center (for Windows Vista) 
which is needed to communicate with the device.

During the installation, the device connectivity software will try  •
to connect to the Solmetric SunEye device.  For Windows XP and 
Windows 2000, and devices that are labeled “SunEye-100N v2”, 
ActiveSync will automatically start the Synchronization Setup 
Wizard. Click Next to setup synchronization settings. None of the 
items listed under Information Type should be checked. Click Next to 
fi nish. 

You can now launch the Solmetric SunEye Desktop Companion from  •
the Solmetric SunEye icon on your desktop or from the start button 
Start » All Programs » Solmetric SunEye » Solmetric SunEye.

 • If this is the fi rst time launching the Solmetric SunEye Desktop 
Companion, or there has never 
been data transferred from the 
hand-held device, then there is 
nothing that can be done on the 
desktop at this point other than 
viewing the User’s Guide. You 
will see a screen like the one to 
the right.

You can view the User’s Guide  •
by selecting Help » Solmetric 
SunEye User’s Guide…

You can exit the application by selecting  • File » Exit.    



4

2  Power up the Solmetric SunEye   
Connect the AC charger cable between your Solmetric SunEye and a  •
wall outlet or connect the Device/USB cable between the Solmetric 
SunEye and a PC that is on. 

If the Solmetric SunEye  is not already on, press the power button  •
briefl y. Once the internal battery has been charged (about 4 hours), the 
device will operate without the external power connection.

Th e battery will slowly discharge even when the device is off . For  •
proper operation, do not allow the battery to completely discharge. 
When the Solmetric SunEye is not in use, connect its AC power or 
Device/USB cable to a PC that is on. 

Note: Operating Temperature  Th e Solmetric SunEye device 
should not be operated outside the temperature range of 32°F 
to 104°F, or be exposed to temperatures below -4°F or above 
140°F.  Even though the ambient temperature may be 80ºF, the 
temperature of the device left in direct sun for half an hour can 
easily reach 130ºF or more.

3  Set Date and Time
If this is the fi rst time turning on the Solmetric SunEye, you will see the  •
screen to the right. 

Using your fi nger on the  •
touchscreen, select the main 
menu icon at the bottom-left 
corner of the screen   then  

  then select Set Date and 
Time… 

You will see the  • Set Date 
and Time dialog box.  Set the 
correct date, time, and time 
zone. Press Set to save.

Th e Solmetric SunEye touchscreen user interface has been designed to  •
work with your fi nger. Th ere is no need to use the stylus. You will fi nd 
that using your fi ngernail works best.

Main Menu Icon 
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4  Create a New Session
Sessions contain a collection of readings for a particular site called  •
skylines. You will generally create a new session for a new client or site 
visit.

Select  •  » Session » New… You will see the New session dialog box.

Accept the default session name “Session 1” by pressing  • Next to 
advance to the next screen. 

Specify the location from  •
a list of cities by selecting 
List of cities for the current 
region.  Select the state and 
then the closest city to where 
you are located.  

Select  • Done. Th e Solmetric 
SunEye will load the location 
information.  

You will see the  • Session Properties that lists the information you 
entered for the session.
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5  Capture a Skyline
A skyline is the solar access measurement for a particular location at 
the site. For example, you might capture a skyline on the east side of a 
roof and then capture another skyline on the west side of the roof.

Select  •  » Skyline » New… You will see a live preview of the skyline 
through the fi sh-eye lens with 
the sunpaths superimposed 
on top.

Be sure the protective cover  •
is open all the way so that the 
compass is level.

If you are in the Northern  •
Hemisphere, orient the 
Solmetric SunEye toward 
magnetic south by lining 
up the white end of the compass arrow with S.  If the Southern 
Hemisphere, orient it north by lining up the white end of the compass 
arrow with N (magnetic declination is automatically accounted for). 

Hold the instrument level by observing the bubble level. It is level when  •
the bubble is inside the inner circle.

Press  • Snap or press the center of the 5-way navigation button.

Select  •  » Skyline » Properties… to change the properties of a 
skyline. You can change the panel tilt and panel azimuth by tapping on 
the Panel Tilt and Panel Azim numeric boxes.

Note: panel azimuth values are true, not magnetic.
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6  View the Resulting Data
Th e Solmetric SunEye automatically processes the skyline to determine 
the solar access. It is important 
to verify that the open sky 
(yellow) versus obstructions 
(green) have been identifi ed 
correctly. If not, you can use 
the edit feature. 

Th e display shows the 
annual sunpaths and annual 
and seasonal solar access 
percentages.

 • Select  » View » Monthly 
solar access. You will see a bar 
chart of the monthly solar 
access.

You can return to the annual  •
sunpath view by selecting 

 » View » Annual sunpaths.

You can capture another  •
skyline by selecting 

 » Skyline » New…  
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7 	 Transfer Data To Desktop PC
After Installing the Solmetric SunEye desktop companion software on 
your desktop PC, you can transfer your data from the hand-held unit to 
your PC.  

Within the desktop application select File » Transfer from Device. 

This will transfer all sessions and skylines from your hand-held device 
to your desktop PC.  

! 	 Soft Reset
If your Solmetric SunEye device appears to not be responding, you 
may need to do a “soft reset” to restart the application.  Under normal 
use, this reset is not needed.  A reset will not cause you to lose any data 
stored on the device. 

To initiate a soft reset, press the stylus provided or the end of a bent-
open paperclip into the pin hole on the right side of the Solmetric 
SunEye, next to the Device/USB port.  The Solmetric SunEye device 
will then reset and start running again.

	 More Information: For more detailed instructions or to learn 
about other features of the Solmetric SunEye, you can access the 
User’s Guide from the installation CD or the Desktop Companion 
software by selecting Help » Solmetric SunEye User’s Guide.
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Limited Hardware and Software Warranty
This Solmetric software and the Solmetric SunEye™ hardware (“Hardware”) are warranted against 
defects in materials and workmanship for a period of one year when purchased in the United States or 
two years when purchased outside the United States.  During the warranty period, Solmetric will, at its 
option, either repair or replace products which prove to be defective.  The warranty period begins on the 
date of shipment.  

For warranty service or repair, this product must be returned to the appropriate authorized repair center 
listed in the Solmetric SunEye User’s Guide.  No returns will be accepted without an RMA (obtain from 
Technical Support). For products returned for warranty service, the Buyer shall pay for shipping charges 
to send the product to the repair center, and the repair center shall pay for shipping charges to return the 
product to the Buyer.  However, the Buyer shall pay all shipping charges, duties, and taxes for products 
returned to the repair center from a country outside of the United States.

The forgoing warranty shall not apply to defects resulting from improper or inadequate maintenance by 
the Buyer, unauthorized modification or misuse, or operation outside of the environmental specifications 
for the product.  Unauthorized modification includes disassembly of the Solmetric SunEye hardware, 
removal of any part of the Solmetric SunEye hardware, modification to the operating system or operating 
system settings of the Solmetric SunEye, or the installation of software on the device other than Solmet-
ric SunEye software.

The design and construction of any system or building by the Buyer is the sole responsibility of the Buyer.  
Solmetric does not warrant the Buyer’s system, products, or malfunction of the Buyer’s system or prod-
ucts.  In addition Solmetric does not warrant any damage that occurs as a result of the Buyer’s system, 
product, or the Buyer’s use of Solmetric products.

To the extent permitted by applicable law, THE FOREGOING LIMITED WARRANTY IS IN LIEU OF ALL OTH-
ER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, AND WE DISCLAIM ANY AND ALL IMPLIED 
WARRANTIES OR CONDITIONS, INCLUDING ANY IMPLIED WARRANTY OF TITLE, NONINFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, regardless of whether we know or had 
reason to know of your particular needs. No employee, agent, dealer or distributor of ours is authorized 
to modify this limited warranty, nor to make any additional warranties.

SOME STATES OR COUNTRIES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, 
AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE OR COUNTRY TO 
COUNTRY.

Limited Remedy
Our entire liability and your exclusive remedy shall be the replacement or repair of any Solmetric 
hardware or software not meeting our Limited Hardware And Software Warranty which is returned to an 
authorized repair center with a copy of your receipt.

IN NO EVENT WILL WE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST 
SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING FROM THE USE OF OR 
THE INABILITY TO USE THE SOLMETRIC SOFTWARE OR HARDWARE (EVEN IF WE OR AN AUTHORIZED 
DEALER OR DISTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF THESE DAMAGES), OR FOR ANY 
CLAIM BY ANY OTHER PARTY.

SOME STATES OR COUNTRIES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

PLEASE CONTACT TECHNICAL SUPPORT BEFORE RETURNING ANY PRODUCT.
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Willkommen
vielen Dank für den Kauf des Solmetric SunEye™, das revolutionäre 
neue Werkzeug für Sonneneinstrahlungs- und Verschattungsanalyse. 
Wir sind zuversichtlich, daß Sie die einfache Handhabung und den 
hohen Nutzwert für Ihren Einsatz schätzen werden.

Bitte vergewissern Sie sich, dass Sie die folgenden Gegenstände 
erhalten haben:

Solmetric SunEye••

Gepolsterte Tragetasche••

CD-ROM••

ActiveSync/USB-Kabel••

Netzladegerät mit Adapter••

Schulterriemen••

Stift••

Kurzanleitung••

Die Bedienungsanleitung wird in elektronischem Format geliefert, und 
ist über die CD-ROM oder über das „Hilfe“-Menü in der Desktop-
Software zugänglich.

Nochmals herzlichen Dank, und bitte besuchen Sie unsere Webseite 
www.solmetric.com, um sich über neue Softwarerevisionen oder 
neue Produkte zu informieren.

Ihr Solmetric Team

Die Verpackung und das Briefpapier aller Solmetric-Produkte ist aus Recycling- oder 
wiederverwendeten Materialien hergestellt.
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Solmetric SunEyeTM Kurzanleitung

1 Kompass

2 Schutzabdeckung

3 Ein-/Austaste

4 Fischaugenobjektiv und 
Digitalkamera 

5 Wasserwaage

6 Touchscreen-Bildschirm

7 5-Wege-Navigationstaste

8 Geräte-/USB-Anschluss und 
Eingang für Ladegerät

9 Stiftloch für Warmstart

10 Stativhalterung

11 Befestigungspunkte für 
Schultergurt
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auf der Unterseite
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1  Installation der Solmetric SunEye-
Desktopsoftware von der CD-ROM
Legen Sie die mit dem Solmetric SunEye-Gerät mitgelieferte CD- •
ROM in das CD-Laufwerk Ihres Windows Vista-, Windows XP- oder 
Windows 2000-Desktopcomputers ein.

Falls sich der Willkommensbildschirm nicht automatisch öff net,  •
klicken Sie auf Start, Arbeitsplatz und doppelklicken Sie dann auf das 
CD-Laufwerk. Sie können die Datei setup.exe auch direkt von der CD-
ROM ausführen.  Befolgen Sie die Anweisungen.  Zur Kommunikation 
mit dem Gerät werden, falls erforderlich, automatisch die Programme 
Microsoft ActiveSync (für Windows XP und Windows 2000) oder 
Windows Mobile Device Center (für Windows Vista) installiert.

Während der Installation versucht die Konnektivitätssoftware des  •
Geräts, sich mit dem Solmetric SunEye-Gerät zu verbinden.  Bei 
Windows XP- und Windows 2000-Geräten sowie Geräten mit der 
Bezeichnung „SunEye-100N v2“ wird ActiveSync automatisch den 
Assistent für die Synchronisierungseinrichtung starten. Klicken Sie 
auf „Weiter“, um die Synchronisierungseinstellungen einzurichten. 
Keine der Optionen unter Informationstyp sollte markiert sein. 
Klicken Sie auf Weiter, um die Einrichtung abzuschließen. 

Nun können Sie die Solmetric SunEye-Desktopsoftware vom Solmetric  •
SunEye-Symbol auf Ihrem Desktop oder über die Schaltfl äche Start 
starten: Start » Alle Programme » Solmetric SunEye » Solmetric 
SunEye.

 • Wenn Sie die Solmetric SunEye-Desktopsoftware zum ersten Mal 
starten oder noch nie Daten 
vom tragbaren Gerät 
übertragen haben, können Sie 
im Augenblick nur das 
Benutzerhandbuch anzeigen. 
Der Bildschirm sieht so aus 
wie auf der Abbildung rechts.

Wählen Sie zum Lesen des  •
Benutzerhandbuchs die 
Option Hilfe » Solmetric 
SunEye Benutzerhandbuch…

Wählen Sie  • Datei » Schließen, um die Anwendung zu beenden.
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2  Einschalten des Solmetric SunEye   
Stecken Sie ein Ende des Kabels des Ladegeräts in Ihr Solmetric  •
SunEye-Gerät und das andere Ende in eine Steckdose oder verwenden 
Sie das Geräte-/USB-Kabel, um Ihr Solmetric SunEye-Gerät mit einem 
eingeschalteten PC zu verbinden. 

Wenn das Solmetric SunEye-Gerät noch nicht eingeschaltet ist,  •
drücken Sie kurz auf die Ein-/Austaste. Nachdem die interne Batterie 
vollständig geladen ist (dies dauert etwa 4 Stunden), arbeitet das Gerät 
ohne externe Stromversorgung.

Die Batterie wird sich langsam entladen, auch wenn das Gerät  •
ausgeschaltet ist. Damit das Gerät einwandfrei funktioniert, darf 
die Batterie nie vollständig entladen sein. Schließen Sie daher das 
Solmetric SunEye-Gerät an das mitgelieferte Ladegerät an oder 
verbinden Sie es über den Geräte-/USB-Anschluss mit einem 
eingeschalteten PC. 

	 Anmerkung: Betriebstemperatur Das Solmetric SunEye-Gerät 
sollte nicht bei Temperaturen außerhalb des Temperaturbereichs 
von 0 °C bis 40 °C betrieben bzw. Temperaturen unter 
-20 °C oder über 60 °C ausgesetzt werden. Auch wenn die 
Umgebungstemperatur etwa 27 ºC beträgt, könnte die Temperatur 
des Geräts nach einer halben Stunde direkter Sonnenbestrahlung 
leicht auf 54 ºC oder mehr ansteigen.

3  Datum und Uhrzeit einstellen
Wenn Sie den Solmetric SunEye   zum ersten Mal einschalten, sieht der  •
Bildschirm wie in der rechts dargestellten Abbildung aus. 

Wählen Sie mit dem Finger  •
auf dem Touchscreen das 
Menüsymbol in der linken 
unteren Ecke des Bildschirms 
aus  danach  und wählen 
Sie dann Datum und Zeit 
einstellen….

“Hauptemü”-Ikone
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Das Dialogfeld  • Datum und Zeit einstellen wird angezeigt.  Stellen Sie 
das korrekte Datum, die Uhrzeit und die Zeitzone ein. Drücken Sie 
zum Speichern auf Einrichten.

Die Touchscreen-Benutzeroberfl äche des Solmetric SunEye   kann  •
mit dem Finger bedient werden. Der Stift muss nicht verwendet 
werden. Sie werden feststellen, dass es mit dem Fingernagel am besten 
funktioniert.

4  Eine neue Sitzung erstellen
Eine Sitzung enthält eine Auswahl von Messwerten für einen  •
bestimmten Standort. Diese werden Horizonte genannt. Im 
Allgemeinen erstellen Sie für jeden neuen Kunden oder bei jedem 
Besuch eines neuen Standorts eine neue Sitzung.

Wählen Sie  •  » Sitzung » Neu … Das Dialogfeld Neue Sitzung wird 
geöff net.

Übernehmen Sie den Standard-Sitzungsnamen „Sitzung 1“, indem Sie  •
auf Weiter drücken, um zum nächsten Bildschirm zu gelangen. 

Wählen Sie das Bundesland  •
und dann die Stadt aus, die 
Ihrem Standort am nächsten 
liegt.  

Wählen Sie  • Erledigt aus. Der 
Solmetric SunEye lädt die 
Standortinformationen.  

Es werden nun die  •
Sitzungseigenschaften 
mit den von Ihnen für diese 
Sitzung eingegebenen Informationen angezeigt.
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5  Einen Horizont erfassen
Ein Horizont ist die Messung der Sonnenverfügbarkeit für einen 
bestimmten Ort am Standort. Sie können beispielsweise den Horizont 
auf der östlichen Dachseite und dann einen weiteren Horizont auf der 
westlichen Dachseite erfassen.

Wählen Sie   •  » Horizont » Neu… Es wird eine aktuelle Vorschau 
des Horizonts durch das 
Fischaugenobjektiv angezeigt, 
und die Sonnenpfade sind 
darüber eingeblendet.

Achten Sie darauf, dass die  •
Schutzabdeckung komplett 
geöff net ist, damit der 
Kompass eben ist.

Richten Sie den Solmetric  •
SunEye   in Richtung des 
magnetischen Südens aus, 
indem Sie die weiße Spitze des Kompasspfeils auf das S zeigen lassen 
(die magnetische Deklination wird hier automatisch berücksichtigt).

Halten Sie das Instrument waagrecht und beobachten Sie dazu die  •
Wasserwaage. Das Instrument ist waagerecht, wenn sich die Blase im 
inneren Kreis befi ndet.

Drücken Sie auf  • Verankern oder drücken Sie auf die Mitte der 
5-Wege-Navigationstaste.

Wählen Sie   •  » Horizont » Eigenschaften… um die Eigenschaften 
eines Horizonts zu ändern.  Sie können den Neigungswinkel und den 
Azimut durch Antippen der Zahlenfelder für Panelneigungswinkel 
und Panelazimut ändern. 

Hinweis: Die Werte für den Panelazimut sind genaue und keine 
magnetischen Werte.
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6  Ansicht der Ergebnisdaten
 • Solmetric SunEye verarbeitet automatisch den Horizont zur 

Bestimmung der 
Sonnenverfügbarkeit. Es muss 
unbedingt überprüft werden, 
ob die freien Himmelsbereiche 
(gelb) gegenüber den 
Bereichen mit Hindernissen 
(grün) korrekt identifi ziert 
wurden. Falls nicht, können 
Sie die Funktion Bearbeiten 
verwenden. 

Die Anzeige zeigt  •
die jährlichen Sonnenpfade sowie die Prozentsätze für die 
Sonnenverfügbarkeit pro Jahr und pro Jahreszeit.

 • Wählen Sie   » Ansicht » Monatliche Sonnenverfügbarkeit. Es 
wird ein Balkendiagramm mit 
der monatlichen 
Sonnenverfügbarkeit 
angezeigt.

Wählen Sie   •  » Ansicht » 
Jährliche Sonnenpfade, um 
zur Ansicht der jährlichen 
Sonnenpfade zurückzukehren

WählenSie   •  » Horizont 
» Neu, um einen neuen 
Horizont zu erfassen. 
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7 	 Daten zum Desktop-PC übertragen
Nach der Installation der Solmetric SunEye  -Desktopsoftware auf 
Ihrem PC können Sie die Daten von Ihrem tragbaren Gerät auf Ihren 
PC übertragen.  

Wählen Sie in der Desktopanwendung die Option Datei » 
Übertragung von Gerät. Damit werden alle Sitzungen und Horizonte 
von Ihrem tragbaren Gerät auf Ihren Desktop-PC übertragen.  

! 	 Warmstart
Falls Ihr Solmetric SunEye -Gerät nicht reagiert, müssen Sie 
möglicherweise einen „Warmstart“ durchführen, um die Anwendung 
neu zu starten.  Bei normaler Benutzung ist dieser Neustart nicht 
erforderlich.  Bei einem Neustart mit der Warmstartfunktion verlieren 
Sie keine gespeicherten Daten.

Um einen Warmstart durchzuführen, drücken Sie den mitgelieferten 
Stift oder das Ende einer aufgebogenen Büroklammer in die kleine 
Öffnung auf der rechten Seite des Solmetric SunEye   neben dem 
Geräte-/USB-Anschluss.  Das Solmetric SunEye  -Gerät wird damit 
neu gestartet.

Ausführlichere Informationen hierzu oder zu weiteren Funktionen 
des Solmetric SunEye   finden Sie im Benutzerhandbuch auf der 
Installations-CD oder in der Software. Wählen Sie Hilfe » Solmetric 
Suneye-Benutzerhandbuch. 
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Begrenzte Hardware- und Softwaregarantie 
Für diese Solmetric-Software und die Solmetric SunEye™-Hardware („Hardware“) gilt eine auf ein Jahr 
beschränkte Garantie für Material- und Herstellungsfehler für in den USA gekaufte Produkte, und eine auf 
zwei Jahre beschränkte Garantier für Produkte, die ausserhalb der USA gekauft wurden..  Während des 
Garantiezeitraums wird Solmetric nach eigenem Ermessen Produkte mit nachweislichen Defekten entweder 
reparieren oder ersetzen.  Der Garantiezeitraum beginnt mit dem Versanddatum.   

Für die Inanspruchnahme von Garantieleistungen (Wartung oder Reparatur im Rahmen dieser Garantie) muss 
das Produkt an den im Solmetric SunEye-Benutzerhandbuch genannten zuständigen authorisierten Repara-
turbetrieb  retourniert werden.  Für die Rücksendung eines Produkts  an den Reparaturbetrieb zur Inanspruch-
nahme von Garantieleistungen hat der Käufer sämtliche Versandgebühren zu bezahlen, und der Reparaturbe-
trieb  übernimmt sämtliche Versandgebühren für die Rücksendung des Produkts an den Käufer.  Sendet der 
Käufer das Produkt für die Inanspruchnahme von Garantieleistungen aus einem Land ausserhalb der USA  an 
den Reparaturbetrieb, so trägt der Käufer sämtliche anfallenden Versandgebühren, Zölle und Steuern. 

Diese Garantie gilt nicht für Defekte, die sich aus unsachgemäßem Gebrauch oder unsachgemäßer Wartung 
durch den Käufer, unbefugte Änderung oder Missbrauch oder den Betrieb unter Umgebungsbedingungen 
außerhalb der Produktspezifikationen ergeben.  Die unbefugte Änderung umfasst das Zerlegen der Solmetric 
SunEye-Hardware, das Entfernen von Teilen der Solmetric SunEye-Hardware, die Modifizierung des Betriebs-
systems oder der Einstellungen des Betriebssystems des Solmetric SunEye sowie die Installation einer anderen 
Software als der Solmetric SunEye-Software auf dem Gerät.

Das Design und die Konstruktion von Systemen oder Gebäuden durch den Käufer liegen in der alleinigen 
Verantwortung des Käufers.  Solmetric bietet keine Garantie für die Systeme oder Produkte des Käufers oder 
für Funktionsstörungen der Systeme oder Produkte des Käufers.  Ferner bietet Solmetric keine Garantie für 
Schäden, die sich aus Systemen oder Produkten des Käufers oder aus der Benutzung von Solmetric-Produkten 
durch den Käufer ergeben. 

Im Rahmen des gesetzlich Erlaubten ERSETZT DIESE BESCHRÄNKTE GARANTIE SÄMTLICHE ANDEREN AUS-
DRÜCKLICHEN ODER STILLSCHWEIGENDEN GARANTIEN ODER BEDINGUNGEN. WIR ÜBERNEHMEN KEINE 
HAFTUNG FÜR SÄMTLICHE AUSDRÜCKLICHEN ODER STILLSCHWEIGENDEN GARANTIEN ODER BEDINGUN-
GEN, EINSCHLIESSLICH STILLSCHWEIGENDER GARANTIEN ÜBER BESITZANSPRÜCHE, NICHTVERLETZUNG 
DER RECHTE DRITTER, MARKTGÄNGIGKEIT ODER EIGNUNG FÜR EINEN BESTIMMTEN ZWECK, unabhängig 
davon, ob uns Ihre besonderen Bedürfnisse bekannt waren oder wir Grund zur Kenntnis Ihrer Bedürfnisse hat-
ten. Kein Mitarbeiter, Agent, Händler oder Vertriebspartner von Solmetric ist zur Änderung dieser beschränkten 
Garantie oder zur Gewährung zusätzlicher Garantien befugt. 

IN EINIGEN BUNDESSTAATEN DER USA ODER ANDEREN LÄNDERN IST DER AUSSCHLUSS IMPLIZITER 
GARANTIEN NICHT ZULÄSSIG. DIESER AUSSCHLUSS GILT ALSO UNTER UMSTÄNDEN NICHT FÜR SIE. DIESE 
GARANTIE VERLEIHT IHNEN BESTIMMTE GESETZLICHE RECHTE, UND UNTER UMSTÄNDEN HABEN SIE WEIT-
ERE RECHTE, DIE VON LAND ZU LAND ODER VON BUNDESSTAAT ZU BUNDESSTAAT VERSCHIEDEN SIND. 

Beschränktes Rechtsmittel 
Unsere gesamte Haftung und Ihr ausschließliches Rechtsmittel umfassen den Ersatz oder die Reparatur von 
Solmetric-Hardware oder -Software, die nicht unserer begrenzten Hardware- und Softwaregarantie entsprech-
en und die an einen autorisierten Reparaturbetrieb zusammen mit einer Kopie Ihres Kaufbelegs zurückgesandt 
werden. 

WIR SIND IN KEINEM FALL HAFTBAR FÜR SCHÄDEN, EINSCHLIESSLICH GEWINNEINBUSSEN, VERLUST VON 
ERSPARNISSEN ODER SONSTIGER ZUFÄLLIG ENTSTANDENER ODER FOLGESCHÄDEN, DIE SICH AUS DEM 
GEBRAUCH ODER DER UNFÄHIGKEIT ZUM GEBRAUCH DER SOLMETRIC-SOFTWARE ODER -HARDWARE 
ERGEBEN (DIES GILT AUCH DANN, WENN WIR ODER EIN AUTORISIERTER HÄNDLER ODER VERTRIEB ÜBER 
DIE MÖGLICHKEIT SOLCHER SCHÄDEN IN KENNTNIS GESETZT WORDEN WAREN), ODER FÜR SCHADENSER-
SATZANSPRÜCHE DRITTER. IN EINIGEN BUNDESSTAATEN DER USA ODER ANDEREN LÄNDERN IST DIE BES-
CHRÄNKUNG ODER DER AUSSCHLUSS DER HAFTUNG FÜR ZUFÄLLIG ENTSTANDENE ODER FOLGESCHÄDEN 
NICHT ZULÄSSIG, SODASS DIESE BESCHRÄNKUNG UNTER UMSTÄNDEN NICHT AUF SIE ZUTRIFFT. 

BITTE WENDEN SIE SICH AN DEN KUNDENDIENST BEVOR SIE EIN PRODUKT EINSCHICKEN.
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Bienvenido
Gracias por su compra del Solmetric SunEye™, la nueva 
herramienta revolucionaria para analizar el acceso solar y la 
sombra.  Confiamos en que le resultará una herramienta fácil de 
usar y justa para el trabajo.

Por favor, compruebe que ha recibido los siguientes elementos:

Solmetric SunEye••

Estuche acolchado para transporte••

CD-ROM••

Cable ActiveSync/USB••

Cargador de pared con adaptador••

Tirante••

Lápiz óptico••

Guía de Inicio Rápido••

La Guía del Usuario se encuentra solamente en formato 
electrónico y es accesible del CD-ROM o por medio del menú de 
ayuda del Software de Sobremesa Acompañante.
 
Gracias de nuevo, y le invitamos a visitar nuestro sitio: 
www.solmetric.com para obtener actualizaciones de software e 
información sobre nuevos productos.

Los Ingenieros y Personal de Solmetric

Solmetric utiliza materiales reciclados o reutilizados en todos sus embalajes y papeles.
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Guía del Solmetric SunEyeTM

1 Brújula 6 Pantalla táctil y LCD

2 Cubierta protectora 7 Botón de navegación de 5 
direcciones

3 Botón de encendido/apagado 8 Puerto del cargador y de 
Aparato/USB

4 Lente ojo de pez y cámara digital 9 Agujero para restablecimiento 
parcial

5 Nivel de burbuja 10 Montaje para el trípode

11 Puntos de anclaje del tirante 
para cargar

1

2

3

4

5

6

7

8

9

10

11

debajo
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1  Instalación del Software de 
Sobremesa Acompañante de 
Solmetric SunEye del CD-ROM
Inserte el CD-ROM incluido con Solmetric SunEye en la unidad de  •
CD del ordenador de sobremesa con Windows Vista, Windows XP o 
Windows 2000.

Si la pantalla de bienvenida no se abre automáticamente, haga clic  •
en Inicio y luego en Mi PC; después haga doble clic en la unidad de 
CD o directamente ejecute setup.exe desde el CD-ROM.  Siga las 
instrucciones. Si ya no está instalado, se instalará automáticamente 
Microsoft ActiveSync (para Windows XP y Windows 2000) o Windows 
Mobile Device Center (para Windows Vista), lo que es necesario para 
comunicarse con el aparato.

Durante la instalación, el software de conectividad del aparato  •
intentará conectar con el aparato Solmetric SunEye.  Para Windows 
XP y Windows 2000 y los aparatos etiquetados como “SunEye-100N 
v2”, ActiveSync iniciará automáticamente el asistente Synchronization 
Setup Wizard. Haga clic en “Siguiente” para establecer la 
confi guración de sincronización. Ningún elemento que aparece en 
la opción de Tipo de Información debe estar activado. Haga clic en 
Siguiente para fi nalizar. 

Ahora puede iniciar el Software de Sobremesa Acompañante de  •
Solmetric SunEye desde el icono de Solmetric SunEye del ordenador 
de sobremesa o mediante el botón de inicio Inicio » Todos los 
programas » Solmetric SunEye » Solmetric SunEye.

 • Si es la primera vez que inicia el Software de Sobremesa Acompañante 
de Solmetric SunEye o nunca se 
han transferido datos desde el 
aparato portátil, lo único que 
puede hacer en el ordenador de 
sobremesa en este momento es 
consultar la Guía del Usuario. Verá 
una pantalla como la que aparece a 
la derecha.
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Puede ver la Guía del Usuario seleccionando  • Ayuda » Guía del 
Usuario de Solmetric SunEye…

Puede salir de la aplicación seleccionando  • Archivo » Salir.

2  Encendiendo el Solmetric SunEye                          
Conecte el cable del cargador de CA de Solmetric SunEye en una toma  •
mural o conecte el cable de aparato/USB de Solmetric SunEye a un PC 
que esté encendido. 

Si Solmetric SunEye aún no está encendido, pulse brevemente el botón  •
de encendido. Una vez que la batería interna se ha cargado (unas 4 
horas), el aparato funcionará sin la conexión de energía externa.

La batería se descargará lentamente incluso si se apaga el aparato. Para  •
un correcto funcionamiento, no permita que la batería se descargue 
completamente. Cuando el Solmetric SunEye no está en uso, conecte 
el cable de energís de CA o el cable del aparato/USB a un PC que esté 
encendido. 

Temperatura de funcionamiento de Solmetric SunEye  El 
aparato Solmetric SunEye no debe funcionar fuera del ámbito 
de temperaturas de 32 °F a 104 °F (de 0 a 40 ºC) ni ser expuesto 
a temperaturas por debajo de los -4 °F (-20 ºC) o por encima de 
los 140°F (60 ºC). Incluso si la temperatura ambiente es de 80 ºF 
(unos 25 ºC) la temperatura de un aparato expuesto al sol directo 
durante media hora puede llegar fácilmente a 130 ºF (unos 54 ºC) 
o más.

3  Establecimiento de fecha y hora
Si ésta es la primera vez que  •
enciende Solmetric SunEye, verá la 
pantalla que aparece a la derecha. 

Con el dedo en la pantalla táctil,  •
seleccione el icono de menú que 
aparece en la esquina inferior 
derecha de la pantalla   y  a 
continuación   y luego , seleccione 
Establecer fecha y hora… Icono del Menú Principal
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Aparecerá el cuadro de diálogo  • Establecer Fecha y Hora.  Establezca 
la fecha, la hora y la zona horaria correctas. Pulse Establecer para 
almacenar.

La interfaz del usuario de la pantalla táctil de Solmetric SunEye se ha  •
diseñado para funcionar usando el dedo. No es necesario utilizar el 
lápiz óptico. Comprobará que utilizar la uña del dedo funciona mejor.

4  Creación de una sesión nueva
Las sesiones contienen una recopilación de lecturas de un sitio  •
determinado que son denominados “horizontes.” Generalmente se 
suele crear una sesión nueva para un cliente o visita de sitio.

Seleccione •    » Sesión » Nueva… Aparecerá el cuadro de diálogo 
Nueva sesión.

Acepte el nombre de sesión predeterminado “Session 1” pulsando  •
Siguiente para avanzar a la siguiente pantalla. 

Especifi que el sitio de  •
una lista de ciudades, por 
seleccionar Lista de Ciudades 
para la Region Actual. 
Seleccione el estado y, a 
continuación, la ciudad más 
cercana a su ubicación.  

Seleccionar  • Listo. 
Solmetric SunEye cargará la 
información de la ubicación.  

Aparecerá  • Propiedades de la Sesión, que muestra la información que 
se ha notado para la sesión.
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5  Captura de un Horizonte
El horizonte es la medida del acceso solar de una ubicación 
determinada del sitio. Por ejemplo, puede capturar  un horizonte 
en la parte oriental de un tejado y capturar otra distinta en la parte 
occidental.

Seleccione   •  » Horizonte » Nuevo… Después de establecer la 
orientación prefi jada del 
horizonte para la sesión, verá 
una vista preliminar actual del 
horizonte a través del lente de 
ojo de pez, con los recorridos 
solares superpuestos.

Asegúrese de que la cubierta  •
protectora esté abierta 
completamente para que la 
brújula esté nivelada.

Oriente el aparato Solmetric  •
SunEye hacia el sur magnético alineando el extremo blanco de la fl echa 
de la brújula con la S (la declinación magnética ya se considera de 
forma automática).

Pulse  • Sacar Foto o el centro del Botón de Navegación de 5 Direcciones.

Seleccione  •  » Horizonte » Propiedades para cambiar las 
propiedades del horizonte.  Puede cambiar la inclinación y el acimut 
del panel tocando en los cuadros numéricos Inclinación del Panel y 
Acimut del Panel. 

Tenga en cuenta que los valores de acimut son verdaderos, no  •
magnéticos.
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6  Visualización de los datos 
resultantes
Solmetric SunEye procesa automáticamente el horizonte para 
determinar el acceso solar. Es 
importante comprobar que el 
cielo abierto (amarillo) frente a 
los obstáculos (verde) se han 
identifi cado correctamente. Si 
no es así, puede utilizar la 
función de edición.

La pantalla muestra los 
recorridos solares anuales y 
los porcentajes de acceso solar 
anuales y estacionales.

 • Seleccione  » Ver » Acceso solar mensual. Verá un gráfi co de 
barras del acceso solar 
mensual.

Puede volver a la vista  •
de recorrido solar anual 
seleccionando  » Ver » 
Recorridos solares anuales.

Puede capturar otro imagen  •
del horizonte seleccionando 

 » Horizonte » Nueva.  
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7 	 Transferencia de datos al PC de 
Sobremesa
Después de instalar el software acompañante de sobremesa de 
Solmetric SunEye en el PC de sobremesa, puede transferir datos de la 
unidad portátil al PC.  

En la aplicación de sobremesa, seleccione Archivo » Transferir del 
Aparato. 

De esta forma, se transferirán todas las sesiones y horizontes del 
aparato portátil al PC de sobremesa.

! 	 Restablecimiento parcial
Si su aparato Solmetric SunEye no responde, puede que deba hacer un 
“restablecimiento parcial” para reiniciar la aplicación. Bajo uso normal, 
no será necesario.  El restablecimiento no provocará la pérdida de 
ningún dato almacenado en el aparato. 

Para iniciar un restablecimiento parcial, presione con el lápiz óptico 
proporcionado o el extremo de un clip abierto en el agujero de la parte 
derecha del aparato Solmetric SunEye, junto al puerto de Aparato/USB.  
El aparato Solmetric SunEye se restablecerá y empezará a funcionar de 
nuevo.

	 Para obtener instrucciones detalladas o conocer otras funciones 
de Solmetric SunEye, puede acceder a la Guía del Usuario desde 
el CD de instalación o el Software de Sobremesa Acompañante 
seleccionando Ayuda > Guía del Usuario de Solmetric SunEye.
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Garantía limitada de hardware y software
El software de Solmetric y el hardware de Solmetric SunEye™ (“Hardware”) están garantizados con 
respecto a los defectos en los materiales y la fabricación por un período de un año si se compran en los Es-
tados Unidos o por un período de dos años si se compran fuera de los Estados Unidos. Durante la garantía, 
Solmetric reparará o sustituirá, a su discreción, los productos que se haya demostrado que son defectuosos. 
La garantía comienza en la fecha del envío. 

Para cualquier reparación bajo garantía, el producto debe devolverse al respectivo centro de reparación 
autorizado que aparece en la Guía del usuario de Solmetric SunEye. No se aceptarán devoluciones sin una 
RMA o autorización de devolución de mercancía (que puede obtenerse del departamento de asistencia 
técnica). Si los productos se devuelven para una reparación bajo garantía, el Comprador pagará los gastos 
de envío del producto al centro de reparación  y el centro de reparación pagará los gastos de envío para 
la devolución del producto al Comprador. Sin embargo, el Comprador pagará todos los gastos de envío, 
derechos de aduanas e impuestos de aquellos productos enviados al centro de reparación desde otro país 
fuera de los Estados Unidos.
La anterior garantía no se aplicará a los defectos que sean resultado de un mantenimiento inadecuado 
por parte del Comprador, la modificación no autorizada, mal uso o funcionamiento que no respete las 
especificaciones medioambientales del producto. La modificación no autorizada incluye el desensamblaje 
del hardware de Solmetric SunEye, la extracción de cualquier pieza del hardware de Solmetric SunEye, la 
modificación del sistema operativo o de la configuración del sistema operativo de Solmetric SunEye o la 
instalación en el dispositivo de un software que no sea Solmetric SunEye.

El diseño y la construcción de cualquier sistema o edificio por parte del Comprador es responsabilidad 
exclusiva del mismo. Solmetric no ofrece garantía sobre el sistema o los productos del Comprador o el mal 
funcionamiento del sistema o productos del Comprador. Además, Solmetric no ofrece garantía sobre los 
daños que se produzcan como resultado del sistema o producto del Comprador o del uso de los productos 
Solmetric por parte del Comprador.

Hasta donde lo permita la ley aplicable, LA GARANTÍA LIMITADA ANTERIOR SE OFRECE EN LUGAR 
DE OTRAS GARANTÍAS O CONDICIONES, EXPRESAS O IMPLÍCITAS, Y RENUNCIAMOS A CUALQUIER 
GARANTÍA O CONDICIÓN IMPLÍCITA, INCLUIDAS LAS GARANTÍAS IMPLÍCITAS DE TÍTULO, NO CUMPLIM-
IENTO, COMERCIABILIDAD O ADECUACIÓN PARA UN FIN CONCRETO, independientemente del conocimien-
to, o razón para ello, de las necesidades particulares. Ninguno de nuestros empleados, representantes o 
distribuidores está autorizado a modificar esta garantía limitada ni a ofrecer garantías adicionales.

ALGUNOS ESTADOS O PAÍSES NO PERMITEN LA EXCLUSIÓN DE LAS GARANTÍAS IMPLÍCITAS, PUEDE QUE 
LA EXCLUSIÓN ANTERIOR NO SE APLIQUE EN ALGUNOS CASOS. ESTA GARANTÍA LE OFRECE DERECHOS 
JURÍDICOS ESPECÍFICOS, AUNQUE PUEDE QUE DISFRUTE DE OTROS DERECHOS QUE PUEDEN VARIAR DE 
UN ESTADO A OTRO O DE UN PAÍS A OTRO.

Medidas de corrección limitadas
Nuestra única responsabilidad y sus únicas medidas de corrección son la sustitución o reparación de cual-
quier hardware o software de Solmetric que no cumpla la Garantía limitada de hardware y software que se 
devuelva a un centro de reparación autorizado con una copia de la factura.

EN NINGÚN CASO SEREMOS RESPONSABLES ANTE USTED POR NINGÚN DAÑO, INCLUIDA LA PÉRDIDA 
DE BENEFICIOS, DE AHORROS U OTROS DAÑOS INCIDENTALES O CONSECUENTES DERIVADOS DEL USO 
O LA IMPOSIBILIDAD DE USO DEL SOFTWARE O HARDWARE DE SOLMETRIC (INCLUSO SI NOSOTROS O 
ALGÚN DISTRIBUIDOR AUTORIZADO HA SIDO AVISADO DE LA POSIBILIDAD DE ESTOS DAÑOS) O POR 
RECLAMACIÓN DE UN TERCERO.

ALGUNOS ESTADOS O PAÍSES NO PERMITEN LA LIMITACIÓN O EXCLUSIÓN DE RESPONSABILIDAD POR 
DAÑOS INCIDENTALES O CONSECUENTES, POR LO QUE PUEDE QUE LA LIMITACIÓN ANTERIOR NO SE 
APLIQUE.

PÓNGASE EN CONTACTO CON EL DEPARTAMENTO DE ASISTENCIA TÉCNICA ANTES DE DE-
VOLVER CUALQUIER PRODUCTO.
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Bienvenue
  

Merci d’avoir choisi Solmetric SunEye™, le nouvel outil révolutionnaire 
d’analyse de masques et d’ensoleillement. Nous sommes convaincus 
que vous le trouverez facile d’emploi et tout à fait adaptée à sa mission.

Veuillez vérifier que vous avez bien reçu les éléments suivants:

Solmetric SunEye™••

Malette de transport thermoformée ••

CD-ROM••

Câble ActiveSync/USB••

Chargeur secteur avec adaptateur••

Chargeur automobile••

Bandoulière••

Stylet••

Guide de démarrage rapide••

Le guide de l’utilisateur est fourni uniquement en format électronique 
et est accessible à partir du CD-ROM ou via le menu Aide du logiciel 
Desktop Companion.
 
Merci encore et n’hésitez pas à venir visiter notre site Web à l’adresse 
www.solmetric.com pour y trouver les mises à jour logicielles et de 
nouveaux produits.

Les ingénieurs et les équipes Solmetric

Tous les emballages et notices Solmetric sont réalisés à partir de matériaux recyclés ou 
réutilisés.
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Guide de démarrage rapide du 
Solmetric SunEyeTM

1 Boussole 6 Écran tactile et LCD

2 Couvercle de protection 7 Bouton de navigation 5 directions

3 Bouton marche/arrêt 8 Port Appareil/USB et chargeur

4 Objectif fi sh-eye et appareil 
photo numérique 

9 Orifi ce de réinitialisation 
manuelle

5 Niveau à bulle 10 Trou fi leté pour montage sur 
trépied

11 Points de fi xation de la 
bandoulière

1

2

3

4

5

6

7

8

9

10

11

dessous l’appareil
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1  Installation du logiciel SunEye 
de Solmetric Desktop Companion 
depuis le CD-ROM
Insérez le CD-ROM livré avec SunEye de Solmetric dans le lecteur  •
de CD de votre ordinateur sous Windows Vista, Windows XP, ou 
Windows 2000.

Si l’écran d’accueil ne s’ouvre pas automatiquement, cliquez sur  •
Démarrer, puis sur Poste de travail et double-cliquez sur le lecteur 
de CD ou exécutez directement setup.exe à partir du CD-ROM. Suivez 
les instructions. S’il n’est pas déjà installé, Microsoft ActiveSync (pour 
Windows XP et Windows 2000) ou Windows Mobile Device Center 
(pour Windows Vista) qui est nécessaire pour communiquer avec 
l’appareil, s’installera automatiquement.

Pendant l’installation, le logiciel de connexion de l’appareil va  •
essayer de se connecter au SunEye de Solmetric. Pour Windows XP 
et Windows 2000 ainsi que pour les appareils arborant l’étiquette 
« SunEye-100N v2 », ActiveSync démarrera automatiquement 
l’Assistant Paramètres de synchronisation. Cliquez sur « Suivant » 
pour défi nir les paramètres de synchronisation. Aucun des éléments 
répertoriés sous Type d’information ne doit être coché. Cliquez sur 
Suivant pour terminer. 

Vous pouvez maintenant lancer le Solmetric SunEye Desktop  •
Companion à partir de l’icône Solmetric SunEye du bureau ou à partir 
du bouton Démarrer » Tous les programmes » Solmetric SunEye » 
Solmetric SunEye.

 • S’il s’agit du premier lancement de Solmetric SunEye Desktop 
Companion ou si aucune donnée n’a jamais été transférée depuis 
l’appareil portatif, rien ne peut être fait sur l’ordinateur à cet instant, à 
part affi  cher le guide de l’utilisateur. 
Vous verrez un écran semblable à 
celui de droite.

Pour affi  cher le guide de l’utilisateur,  •
sélectionnez Aide » Guide de 
l’utilisateur Solmetric SunEye…

Pour quitter l’application,  •
sélectionnez Fichier » Quitter.
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2  Mise sous tension du SunEye de 
Solmetric                          
Branchez le câble du chargeur secteur au SunEye de Solmetric et le  •
boitier sur une prise de courant ou branchez le câble USB entre le 
SunEye de Solmetric et un ordinateur allumé.

Si le SunEye de Solmetric n’est pas encore sous tension, appuyez  •
brièvement sur le bouton d’alimentation. Une fois la batterie interne 
chargée (environ 4 heures), l’appareil est prêt à fonctionner sans 
alimentation externe.

La batterie va se décharger lentement, même si l’appareil est hors  •
tension. Pour un fonctionnement correct, ne laissez pas la batterie se 
décharger complètement. Lorsque le SunEye de Solmetric n’est pas 
utilisé, branchez son chargeur ou le câble USB sur un PC en marche.  

Température de fonctionnement du SunEye de Solmetric 
Le SunEye de Solmetric est conçu pour fonctionner dans la plage 
de températures comprises entre 0°C et 40°C, il ne doit pas être 
exposé à des températures inférieures à -20°C ou supérieures à 
60°C. Bien que la température ambiante puisse être de 26ºC, la 
température de l’appareil laissé au soleil pendant une demi-heure 
peut facilement atteindre 55°C ou plus.

3  Réglage de la date et de l’heure
Lors de la première utilisation du SunEye de Solmetric vous obtiendrez  •
l’écran de droite. 

En vous servant de votre doigt sur  •
l’écran tactile, sélectionnez l’icône 
de menu situé dans l’angle inférieur 
gauche de l’écran , puis  puis 
sélectionnez : Défi nir la date et 
l’heure…

La boîte de dialogue  • Défi nir la 
date et l’heure s’ouvre. Défi nissez Icône Menu Principal
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la date, l’heure et le fuseau horaire qui conviennent. Appuyez sur 
Valider pour enregistrer le réglage.

L’interface utilisateur de l’écran tactile du SunEye de Solmetric a  •
été conçue pour fonctionner avec votre doigt. Il n’est pas nécessaire 
d’utiliser le stylet. Vous constaterez que l’utilisation de votre ongle est 
plus pratique.

4  Création d’une session
Une session contient l’ensemble des mesures d’un site particulier.  •
Une mesure s’appelle un horizon. En règle générale, vous créerez une 
session par nouveau client ou visite de site.

Sélectionnez •   » Session » Nouvelle... La boîte de dialogue Nouvelle 
session s’ouvre.

Nommez ou acceptez le nom de session par défaut « Session 1 » et  •
appuyez sur Suivant pour passer à l’écran suivant. 

Si la première option est  •
sélectionnée, choisissez la 
région, puis la ville la plus 
proche de l’endroit où vous 
vous trouvez et Valider.

Solmetric SunEye charge 
les informations de 
l’emplacement et ouvre la 
boîte de dialogue Propriétés 
de la session qui répertorie 
les informations que vous 
avez saisies pour la session s’affi  che..



36

5  Capture d’un horizon
Un horizon est la mesure de l’ensoleillement d’un emplacement 
particulier sur le site. Par exemple, vous pouvez capturer horizon sur 
le côté Est d’un toit, puis en capturer une autre sur le côté Ouest de ce 
toit.

Sélectionnez   •  » Horizon » Nouveau… 

Verifi ez ou modifi ez les  •
informations de la boite de 
dialogue Orientation du 
panneau et valider. L’écran 
affi  chera alors un aperçu en 
direct de l’horizon à travers 
l’objectif fi sh-eye avec les 
courses du soleil superposées.

Assurez-vous que le  •
couvercle de protection est 
complètement ouvert pour 
que la boussole soit bien de niveau.

Orientez le Solmetric SunEye vers le sud magnétique en alignant  •
l’extrémité blanche de la fl èche de la boussole sur S (la déclinaison 
magnétique est automatiquement prise en compte).

Tenez l’instrument à plat en observant le niveau à bulle. Il est à plat  •
lorsque la bulle se trouve à l’intérieur du cercle.

Appuyez sur  • Capturer ou appuyez au centre du bouton de navigation à 
5 directions.

Sélectionnez   •  » Horizon » Propriétés de l’horizon pour modifi er 
les propriétés d’un horizon. Vous pouvez changer l’inclinaison et 
l’azimut du panneau en appuyant sur les cases numériques Inclinaison 
et Azimut. 

Notez que les valeurs d’azimut du panneau sont  géographiques et non 
magnétiques.
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6  Affi chage des résultats
Le SunEye de Solmetric  analyse automatiquement l’horizon afi n de 
déterminer l’ensoleillement. Il 
est important de vérifi er que le 
ciel ouvert (en jaune) a bien été 
identifi é par rapport aux 
obstructions (en vert). Si ce 
n’est pas le cas, vous pouvez 
utiliser la fonction d’édition.

L’écran affi  che les courses du 
soleil annuelles ainsi que les 
pourcentages d’ensoleillement 
annuels et saisonniers.

Sélectionnez  •  » Affi  chage » Ensoleillement mensuel. Vous verrez 
un histogramme de l’ensoleillement mensuel.

Pour revenir en mode de  •
course du soleil annuelle, 
sélectionnez  » Affi  chage » 
Courses annuelles du soleil.

Pour capturer un autre  •
horizon, sélectionnez   » 
Horizon » Nouveau.
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7 	 Transférer les données vers un PC
Après avoir installé le Solmetric SunEye Desktop Companion sur 
votre ordinateur, vous pourrez transférer vos données depuis l’appareil 
portables vers le PC.

Dans l’application installée sur le PC, sélectionnez Fichier » 
Transférer depuis l’appareil. Ceci va permettre de transférer toutes 
les sessions et tous les horizons depuis l’appareil portable vers 
l’ordinateur.

! 	 Réinitialisation Manuelle
Si votre SunEye de Solmetric ne semble pas répondre, vous devrez 
peut-être effectuer une « Réinitialisation Manuelle» pour relancer 
l’application. Dans une utilisation normale, cette réinitialisation est 
inutile. La réinitialisation ne vous fera pas perdre les données stockées 
dans l’appareil. 

Pour effectuer la réinitialisation manuelle, introduisez le stylet fourni 
ou l’extrémité d’un trombone ouvert dans l’orifice situé sur le côté 
droit du SunEye de Solmetric, à gauche du connecteur de l’appareil. Le 
SunEye de Solmetric redémarre alors et recommence à fonctionner.

	 Pour obtenir des instructions plus détaillées ou pour obtenir 
des informations sur d’autres fonctionnalités du SunEye de 
Solmetric, vous pouvez accéder au guide de l’utilisateur depuis le 
CD d’installation ou à partir du logiciel Desktop Companion en 
sélectionnant Aide » Guide de l’utilisateur SunEye de Solmetric.
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Garantie limitée du matériel et du logiciel
Ce logiciel Solmetric et l’appareil Solmetric SunEye™ sont garantis contre tout défaut de matière ou de 
fabrication pendant une période d’un an s’ils sont achetés aux Etats Unis et de deux ans pour un achat dans 
un autre pays. Durant cette période de garantie, Solmetric pourra, selon son choix, réparer ou remplacer les 
produits s’avérant défectueux. La période de garantie court à partir de la date d’expédition.

Pour bénéficier d’une réparation dans le cadre de la garantie, ce produit doit être renvoyé dans l’un des 
centres de réparation listés dans le guide de l’utilisateur du Solmetric SunEye™. Les retours d’appareils ne 
seront pas acceptés sans un Numero d’Autorisation de Retour NAR (obtenu auprès du Service Technique). 
Pour les produits renvoyés  dans le cadre de la garantie, l’acquéreur devra s’acquitter des frais d’expédition 
du produit jusqu’au Centre de Réparation. Le Centre de Réparation devra s’acquitter des frais d’expédition 
pour renvoyer le produit chez l’acquéreur. Toutefois, l’acquéreur devra s’acquitter des frais d’expédition, des 
droits et des taxes des produits renvoyés au Centre de Réparation depuis un pays en dehors des U.S.A.

La garantie susmentionnée ne s’applique pas aux défauts résultant d’un entretien incorrect ou inadéquat 
par l’acquéreur, d’une modification non autorisée ou d’une mauvaise utilisation, ou de l’emploi en-dehors 
des caractéristiques environnementales du produit. La modification non autorisée inclut le désassemblage 
du matériel Solmetric SunEye™, le retrait d’une partie quelconque du matériel Solmetric SunEye™ , la 
modification du système d’exploitation ou des paramètres du système d’exploitation du Solmetric SunEye™ 
ou l’installation sur l’appareil de logiciels autres que le logiciel Solmetric SunEye™.

La conception et la construction d’un quelconque système solaire par l’acquéreur est la seule responsabilité 
de ce dernier. Solmetric ne garantit pas le système ou les produits de l’acquéreur, ni le bon fonctionnement 
du système ou des produits de l’acquéreur. De plus, Solmetric ne garantit pas les dommages occasion-
nés par l’utilisation du système ou du produit de l’acquéreur ni l’utilisation par l’acquéreur des produits 
Solmetric.
Dans la limite autorisée par la loi, LA GARANTIE LIMITÉE MENTIONNÉE CI-DESSUS REMPLACE TOUTES 
LES GARANTIES OU CONDITIONS, EXPRESSES OU IMPLICITES, ET NOUS REJETONS TOUTE GARANTIE 
OU CONDITION IMPLICITE, Y COMPRIS TOUTE GARANTIE IMPLICITE DE TITRE, DE NON-VIOLATION, DE 
QUALITÉ MARCHANDE OU D’ADÉQUATION À UN BUT PARTICULIER, que nous ayons su ou ayons eu des 
raisons de connaître de vos besoins particuliers. Aucun de nos employés, agents, revendeurs ou distribu-
teurs n’est autorisé à modifier la présente garantie limitée ni à concéder des garanties supplémentaires.

CERTAINS ETATS OU PAYS NE PERMETTENT PAS D’EXCLURE LES GARANTIES IMPLICITES DE SORTE QUE 
LES LIMITATIONS D’EXCLUSIONS CI-DESSUS NE S’APPLIQUENT PAS DANS VOTRE CAS. CETTE GARAN-
TIE VOUS CONFÈRE CERTAINS DROITS SPÉCIFIQUES ; IL EST POSSIBLE QUE VOUS DISPOSIEZ D’AUTRES 
DROITS QUI PEUVENT VARIER D’UN ETAT A L’AUTRE OU D’UN PAYS À L’AUTRE.

Recours exclusifs
Notre entière responsabilité et votre recours exclusif seront le remplacement ou la réparation du matériel 
ou du logiciel Solmetric qui ne répondrait pas aux termes de notre Garantie limitée du matériel et du logiciel 
qui sera renvoyé à un Centre de Réparation autorisé avec une copie de votre facture.

NOUS NE POURRONS EN AUCUN CAS ÊTRE TENUS RESPONSABLES DE DOMMAGES, NOTAMMENT 
PERTES DE PROFITS OU TOUT AUTRE DOMMAGE ACCIDENTEL CONSÉCUTIF A L’UTILISATION OU A 
L’IMPOSSIBILITÉ D’UTILISER LE LOGICIEL OU LE MATÉRIEL SOLMETRIC (MÊME SI NOUS, NOTRE REVEN-
DEUR OU DISTRIBUTEUR AUTORISÉ A ÉTÉ PRÉVENU DE L’ÉVENTUALITÉ DE TELS DOMMAGES), OU DE 
TOUTE RÉCLAMATION PAR TOUTE AUTRE PARTIE.

CERTAINS ETATS OU PAYS NE PERMETTENT PAS D’EXCLURE OU DE LIMITER LES DOMMAGES ACCIDEN-
TELS OU CONSÉCUTIFS, DE SORTE QUE LES LIMITATIONS D’EXCLUSIONS CI-DESSUS NE S’APPLIQUENT 
PAS DANS VOTRE CAS.

VOUS DEVEZ APPELER LE SERVICE APRES VENTE POUR OBTENIR UN N.A.R AVANT DE RE-
TOURNER UN APPAREIL.
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Benvenuto
  
Grazie per avere acquistato Solmetric SunEye™, il 
rivoluzionario strumento per l’analisi della visibilità solare e/o 
ombreggiamento. Siamo certi che troverà questo strumento 
facile da usare e utilissimo per il Suo lavoro.

La preghiamo di verificare di avere ricevuto tutti gli articoli 
seguenti:

Solmetric SunEye™••

Custodia imbottita••

CD-ROM••

Cavo ActiveSync/USB••

Caricabatteria a parete con adattatore••

Tracolla••

Stilo••

Guida rapida••

Il Manuale dell’utente è disponibile solo in formato elettronico 
ed è accessibile dal CD-ROM incluso o dal menu della guida in 
linea del software Desktop Companion.
 
RingraziandoLa nuovamente, La invitiamo a visitare il nostro 
sito Web: www.solmetric.com, in cui troverà gli aggiornamenti 
del software e le novità sui prodotti.

I tecnici e il personale Solmetric

Gli imballaggi e la documentazione dei prodotti Solmetric sono interamente realizzati con 
materiali riutilizzati o riciclati.
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Guida rapida di Solmetric  
SunEyeTM

1 Bussola 6 Touch screen e display LCD

2 Coperchio protettivo 7 Tasto di navigazione a 5 direzioni

3 Pulsante di accensione 8 Connettore dispositivo/USB e di 
carica

4 Obiettivo supergrandangolare e 
fotocamera digitale  

9 Foro di ripristino parziale

5 Livella a bolla 10 Foro di inserimento per cavalletto

11 Ganci di attacco della tracolla

1

2

3

4

5

6

7

8

9

10

11

sul dietro
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1  Installazione del software “Desktop 
Companion per Solmetric SunEye” 
da CD-ROM
Inserire il CD-ROM fornito con Solmetric SunEye nell’unità CD del  •
computer desktop Windows Vista, Windows XP o Windows 2000.

Se non viene visualizzata automaticamente la schermata iniziale,  •
fare clic su Start, quindi su Risorse del computer e fare doppio clic 
sull’unità CD o eseguire direttamente il fi le setup.exe dal CD-ROM.  
Seguire le istruzioni visualizzate.  Se non è già installato, il programma 
di installazione installerà anche Microsoft ActiveSync (per Windows 
XP e Windows 2000) o Windows Mobile Device Center (per Windows 
Vista), necessario per comunicare con il dispositivo.

Durante l’installazione, il software di interfaccia del dispositivo tenta  •
di collegarsi al dispositivo Solmetric SunEye.  Con Windows XP e 
Windows 2000, nonché con i dispositivi che riportano l’etichetta 
“SunEye-100N v2”, ActiveSync avvia automaticamente la procedura 
di confi gurazione guidata della sincronizzazione (Synchronization 
Setup Wizard). Fare clic su “Avanti” per confi gurare le impostazioni di 
sincronizzazione. Non selezionare alcuna delle opzioni in Information 
Type. Fare clic su Avanti per terminare la procedura. 

A questo punto, è possibile avviare “Desktop Companion per Solmetric  •
SunEye  “dall’icona di Solmetric SunEye sul desktop o dal pulsante 
start: Start » Tutti i programmi » Solmetric SunEye » Solmetric 
SunEye.

 • ’Se “Desktop Companion per Solmetric SunEye “ viene avviato per la 
prima volta, o se non sono mai stati 
trasferiti dati dal dispositivo portatile, 
l’unica operazione che è possibile 
eseguire dal PC è la visualizzazione 
del Manuale utente. Viene 
visualizzata una schermata come 
quella riportata a destra.

Per visualizzare il Manuale utente,  •
selezionare Aiuto » Manuale utente 
di Solmetric SunEye…

Per uscire dall’applicazione, selezionare  • File » Esci.
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2  Accensione di Solmetric SunEye                          
Collegare il cavo del caricabatteria CA da Solmetric SunEye a un presa  •
di corrente o collegare il cavo dispositivo/USB da Solmetric SunEye a 
un PC in funzione. 

Se Solmetric SunEye non è già acceso, premere brevemente il pulsante  •
di accensione. Una volta caricata la batteria interna (sono richieste 
circa 4 ore), il dispositivo può essere utilizzato senza il collegamento a 
una sorgente di alimentazione esterna.

La batteria si scarica lentamente anche quando il dispositivo è spento.  •
Per assicurare un funzionamento ottimale, non lasciare scaricare 
completamente la batteria. Quando il dispositivo Solmetric SunEye 
non viene utilizzato, collegare il cavo di alimentazione CA o il cavo 
dispositivo/USB a un PC in funzione.  

		Temperatura di funzionamento di Solmetric SunEye 
Il dispositivo Solmetric SunEye non deve mai essere utilizzato al 
di fuori dell’intervallo di temperatura compreso tra 0°C e 40°C (da 
32°F a 104°F) né essere esposto a temperature inferiori a -20°C 
(-4°F) o superiori a 60°C (140°F). Anche con una temperatura 
ambiente di 27°C (80°F), la temperatura del dispositivo, se lasciato 
al sole per mezz’ora, può facilmente raggiungere i 54°C (130°F) o 
temperature superiori..

3  Impostazione di data e ora
Quando si utilizza Solmetric SunEye per la prima volta, viene 
visualizzata la schermata riportata a destra. 

Con un dito, selezionare sul touch  •
screen l’icona dei menu nell’angolo 
inferiore sinistro dello schermo  

, quindi  e selezionare 
Imposta data e ora….

Viene visualizzata la fi nestra  •
di dialogo Imposta data e ora.  

L’icona Menu Principale
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Impostare la data, l’ora e il fuso orario appropriati. Premere Imposta 
per salvare le impostazioni.

L’interfaccia utente del touch screen di Solmetric SunEye è stata  •
progettata per ricevere gli input con un dito dell’utente. Non è 
necessario utilizzare la stilo. Per interagire con lo schermo, l’unghia 
risulta più effi  cace.

4  Creazione di una nuova sessione
Le sessioni contengono l’insieme dei datti raccolti per un sito specifi co,  •
denominate orizzonti. In genere, viene creata una nuova sessione per 
ciascun nuovo cliente o sito visitato.

Selezionare •   » Sessione  » Nuovo... Viene visualizzata la fi nestra di 
dialogo Nuova sessione.

Accettare il nome predefi nito della sessione “Session 1” premendo su  •
Avanti per passare alla schermata successiva. 

Selezionare lo stato, quindi la  •
città più vicina alla località in 
cui ci si trova.

Selezionare  • Fine. Solmetric 
SunEye carica le informazioni 
sulla posizione

Vengono visualizzate le 
proprietà della sessione 
con tutte le informazioni 
specifi cate per la sessione corrente.
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5  Acquisizione di un orizzonte
Un orizzonte rappresenta il calcolo della visibilità solare per una 
posizione specifi ca all’interno di un sito. Ad esempio, è possibile 
acquisire un orizzonte sul lato est di un tetto, quindi acquisire un 
secondo orizzonte sul lato ovest.

Selezionare   •  » Orizzonte » Nuovo… 

Viene visualizzata 
l’anteprima del orizzonte  
acquisito con l’obiettivo 
supergrandangolare, con le 
traiettorie solari sovrapposte 
all’immagine.

Assicurarsi che il coperchio  •
protettivo sia completamente 
aperto in modo che la bussola 
si trovi a livello.

Orientare il dispositivo Solmetric SunEye in direzione del sud  •
magnetico allineandolo all’estremità di colore bianco dell’ago della 
bussola contrassegnata da una S (la declinazione magnetica viene 
calcolata automaticamente).

Tenere lo strumento a livello osservando la livella a bolla. Lo strumento  •
è a livello quando la bolla si trova all’interno del cerchio centrale.

Premere  • Scatta o premere il centro del tasto di navigazione a 5 
direzioni.

Selezionare  •  » Orizzonte » Proprietà  per modifi care le proprietà 
del orizzonte.  È possibile modifi care l’inclinazione e l’azimut del 
pannello toccando le caselle numeriche Inclinazione pannello e 
Azimut pannello.. 

Tenere presente che i valori dell’azimut sono quelli reali e non quelli 
magnetici.
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6  Visualizzazione dei dati ottenuti
Solmetric SunEye elabora automaticamente l’orizzonte per calcolare  la 
visibilità solare. È importante 
verifi care che “cielo limpido” 
(area gialla) e “ostacoli” (area 
verde) siano stati identifi cati 
correttamente. In caso 
contrario, è possibile utilizzare 
la funzione di modifi ca.

Sul display vengono 
visualizzate le traiettorie 
solari annuali e le percentuali 
stagionali di visibilità solare.

Selezionare  •  » Visualizza » Visibilità solare mensile. Viene 
mostrato un grafi co a barre della  visibilità solare mensile.

Per tornare alla vista delle  •
traiettorie solari annuali, 
selezionare  » Visualizza » 
Traiettorie solari annuali.

Per acquisire una nuova  •
linea di visibilità del cielo, 
selezionare  » Orizzonte » 
Nuovo.
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7 	 Trasferimento dei dati su PC
Una volta installato il software “Desktop Companion per Solmetric 
SunEye “sul PC, è possibile trasferire i dati dall’unità portatile al PC.

Selezionare File » Trasferisci dal dispositivo nell’applicazione 
desktop. Il trasferimento dati sposta tutte le sessioni e li orizzonti dal 
dispositivo portatile al PC. 

! 	 Ripristino parziale
Se il dispositivo Solmetric SunEye non risponde, potrebbe essere 
necessario eseguire un “ripristino parziale” per riavviare l’applicazione.  
In condizioni di funzionamento normali, tale ripristino non è 
necessario.  Il ripristino non causa la perdita dei dati memorizzati sul 
dispositivo.

Per avviare un ripristino parziale, premere con la stilo in dotazione o 
la punta di una graffetta il foro sul lato destro del dispositivo Solmetric 
SunEye , accanto al connettore dispositivo/USB.  Il dispositivo 
Solmetric SunEye viene reimpostato e riavviato.

	 Per istruzioni dettagliate o per conoscere le altre funzioni di 
Solmetric SunEye, consultare il Manuale dell’utente sul CD di 
installazione o nel software “Desktop Companion” selezionando 
? » Solmetric SunEye Manuale utente
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Garanzia limitata su hardware e software
Il software Solmetric e l’hardware Solmetric SunEye™ (“Hardware”) sono garantiti da difetti di materiale e 
fabbricazione per un periodo di un anno se acquistati negli Stati Uniti o di due anni se acquistati fuori dagli 
Stati Uniti. Durante il periodo della garanzia, Solmetric potrà, a propria discrezione, riparare o sostituire i 
prodotti che dovessero dimostrarsi difettosi. Il periodo della garanzia inizia dalla data di spedizione. 

Per gli interventi di assistenza o le riparazioni in garanzia il prodotto deve essere reso all’idoneo centro di 
assistenza autorizzato elencato nel manuale d’uso del SunEye Solmetric. Nessuna resa sarà accettata senza 
autorizzazione alla resa (RMA - da richiedere al supporto tecnico). Nel caso dei prodotti resi per interventi 
di assistenza in garanzia, le spese di spedizione per l’invio del prodotto al centro di assistenza saranno a 
carico dell’acquirente, mentre il centro si addosserà le spese di spedizione per la restituzione del prodotto 
all’acquirente. Tuttavia, nel caso in cui i prodotti vengano resi al centro di assistenza da fuori gli Stati Uniti, 
tutte le relative spese di spedizione, doganali e le imposte saranno a carico dell’acquirente.

La summenzionata garanzia non è valida per difetti derivanti da una manutenzione impropria o inadeguata 
eseguita dall’acquirente, da modifiche non autorizzate, da uso improprio o dall’impiego del prodotto in 
ambienti non conformi alle specifiche indicate. Le modifiche non autorizzate includono lo smontaggio 
dell’hardware Solmetric SunEye, la rimozione di componenti dell’hardware Solmetric SunEye, modifiche 
al sistema operativo o alle impostazioni del sistema operativo del Solmetric SunEye o l’installazione sul 
dispositivo di software diverso da Solmetric SunEye™.

La progettazione e la costruzione di sistemi o edifici da parte dell’acquirente è di esclusiva responsabilità 
dell’acquirente stesso. Solmetric non fornisce alcuna garanzia per sistemi e prodotti dell’acquirente né è 
responsabile del malfunzionamento di sistemi o prodotti dell’acquirente. Solmetric, inoltre, non fornisce 
alcuna garanzia per eventuali danni provocati dall’uso di sistemi o prodotti dell’acquirente o dall’uso di 
prodotti Solmetric da parte dell’Acquirente.

Nella misura massima consentita dalla legge applicabile, LA SUMMENZIONATA GARANZIA LIMITATA 
SOSTITUISCE QUALSIASI ALTRA GARANZIA O CONDIZIONE, ESPLICITA O IMPLICITA, E SOLMETRIC 
DISCONOSCE QUALSIASI GARANZIA O CONDIZIONE IMPLICITA, INCLUSE LE GARANZIE IMPLICITE DI TI-
TOLARITÀ, OSSERVANZA DI NORME O LEGGI , COMMERCIABILITÀ O IDONEITÀ A UNO SCOPO SPECIFICO, 
a prescindere dal fatto che Solmetric sia a conoscenza o abbia motivo di essere a conoscenza di esigenze 
specifiche dell’utente. Nessun dipendente, rappresentante, rivenditore o distributore di Solmetric è autoriz-
zato a modificare la presente garanzia limitata né a rilasciare garanzie aggiuntive.

LE LEGISLAZIONI DI ALCUNI STATI NON AMMETTONO L’ESCLUSIONE DELLE GARANZIE IMPLICITE E 
PERTANTO L’ESCLUSIONE DI CUI SOPRA POTREBBE NON ESSERE VALIDA PER TUTTI GLI UTENTI. LA PRE-
SENTE GARANZIA CONCEDE ALL’UTENTE DIRITTI LEGALI SPECIFICI. L’UTENTE POTREBBE GODERE DI ALTRI 
DIRITTI, CHE VARIANO A SECONDA DELLA LEGISLAZIONE IN VIGORE NEI DIVERSI STATI.

Limitazione di indennizzo
L’intera responsabilità di Solmetric e il solo indennizzo per l’utente è rappresentato dalla sostituzione o la 
riparazione di componenti hardware o software che non soddisfano le condizioni della Garanzia limitata su 
hardware e software di Solmetric e che vengono resi a un centro di assistenza autorizzato, accompagnati da 
una copia della ricevuta d’acquisto.

IN NESSUN CASO SOLMETRIC POTRÀ ESSERE RITENUTA RESPONSABILE DI DANNI, INCLUSI LA PERDITA 
DI PROFITTI E DI RISPARMI O ALTRI DANNI ACCESSORI O INDIRETTI, DERIVANTI DALL’UTILIZZO O 
DALL’IMPOSSIBILITÀ DI UTILIZZARE IL SOFTWARE O L’HARDWARE SOLMENTRIC (ANCHE SE UN RIVENDI-
TORE O UN DISTRIBUTORE AUTORIZZATO È STATO INFORMATO DELLA POSSIBILITÀ DI TALI DANNI) O DI 
QUALSIASI RICHIESTA DI RISARCIMENTO AVANZATA DA TERZI.

LE LEGISLAZIONI DI ALCUNI STATI NON AMMETTONO LA LIMITAZIONE O L’ESCLUSIONE DELLA RESPONS-
ABILITÀ PER DANNI ACCESSORI O INDIRETTI E PERTANTO LA LIMITAZIONE DI CUI SOPRA POTREBBE NON 
ESSERE VALIDA PER TUTTI GLI UTENTI.

CONTATTARE IL SUPPORTO TECNICO PRIMA DELLA RESA DI QUALSIASI PRODOTTO.
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